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1 Introduction

1.1 About Metatude

The Metatude software suite allows you to collect feedback on the performance and activities of
your company from stakeholders such as customers, business partners, co-managers and
employees. This information is vital to your company because it allows you to fine-tune your
business activities and company policies to the perception of your performance. And it is this
information that will allow you to gauge and influence what others say and think about your
company, something that can make or break you. Essential information that constitutes the basis
for your business decisions.

Metatude's web-based software allows you to collect feedback on issues such as:

· customer satisfaction and loyalty;

· employee commitment;

· corporate reputation;

· business ethics;

· service level management.

Metatude is designed for large organizations whose IT infrastructure may be complex and have
many stakeholders. Once the software is installed you can easily define target groups, create
questionnaires, conduct research and manage output for analysis and reporting tools.

For more information on Metatude software, technology and business examples, please consult
our website: http://www.metatude.com
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1.2 About this manual

This manual will show you how to make a questionnaire with the Metatude Dialogue Designer.
After you have read this manual you will be able to create questionnaires, which are processed by
other Metatude software components and sent to respondents as HTML or XML files.

In this manual we will show you how to prepare a questionnaire step by step. After giving you some
general information about the Metatude software suite, we will show you how to install the
application and to create and save dialogue files. After this you will see how to set dialogue
properties and how to create questions in general. The next part of this manual explains the
characteristics and properties of each question type you can create with the Dialogue Designer.
Finally, the interactivity features for the dialogues will be presented.

This manual is dated August 11th, 2004; Metatude will update this documentation if needed.
Please check http://www.metatude.com/support/ for recent versions.
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1.3 The Metatude suite

The Metatude software suite consists of four interacting software components:

1. Metatude Dialogue Server;
2. Metatude Channel Integration Components;
3. Metatude Dialogue Designer;
4. Metatude Project Manager.

The basis of the Metatude architecture is a central server (Metatude Dialogue Server) that needs
to be installed in your organization. This server maintains the connections with databases, stores
and serves the dialogues to stakeholders and collects and stores the collected data in a database.

Once the Dialogue Server is installed, you can manage any stakeholder feedback with two desktop
applications that are relevant for the regular user: the Metatude Dialogue Designer and the
Metatude Project Manager. Consultants, managers and researchers can use these two
applications to prepare questionnaires and manage projects involving stakeholder feedback.

1) Metatude Dialogue Server
The Metatude Dialogue Server (MDS) is the central component within the Metatude architecture.
This server connects to databases and directories with stored stakeholder information,
communicates with electronic channels, stores and serves dialogues and writes results to a
database. All the project information and intelligence to manage projects automatically resides on
this server.

2) Metatude Channel Integration Components
The Metatude Channel Integration Components (MCIC) needs to be installed on an electronic
channel. This allows the channel to communicate with the central server.

3) Metatude Dialogue Designer
The Metatude Dialogue Designer (MDD) is a Windows application that is used to create
questionnaires. With a simple and intuitive interface any user can learn how to create
questionnaires in a matter of minutes. Many question types are supported, e.g. open questions,
multiple choice, multiple response, scale and matrix questions.

4) Metatude Project Manager
With the Metatude Project Manager (MPM) you can manage stakeholder feedback projects. The
MPM can connect via a network to the Metatude Dialogue Server. Once logged on you can
connect databases and directories, create target groups, assign dialogues to (multiple) target
groups and retrieve results in the desired format.



5 Dialogue Designer User Manual

© 2001 - 2004 Metatude

2 Installation

2.1 Operating system and requirements

The Metatude Dialogue Designer is a Windows application. It will run on Windows 98, Windows
NT, Windows 2000 and Windows XP. In order to work with the Metatude Dialogue Designer, you
will need hardware that meets the following minimum specifications:

· 300 MHz Intel or AMD Processor;

· 32 MB RAM;

· 30 MB of available space on the hard disk;

· CD-ROM station.

The CD-ROM station is needed for installation of the software.
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2.2 Installation MDD

Installing from CD-ROM:

· Place the Desktop software CD-ROM in the CD-ROM drive.

· Browse to the CD-ROM drive, choose the directory Dialogue Designer and double click the file
setup.exe.

· Press OK to start the installation procedure and follow the instructions on the screen.

You will see a message when the installation is completed.
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3 Dialogue files

3.1 Creating, saving and previewing dialogues

In order to collect feedback from your stakeholders you need a dialogue/questionnaire. This
chapter tells you how to create and edit a dialogue. A dialogue can consist of different types of
questions. Furthermore you learn how to save and print a dialogue. The output of the Dialogue
Designer is a dialogue file in XML format. If you define a new project with the Metatude Project
Manager you can indicate which dialogue you would like to use.

To start the Dialogue Designer click on the Metatude Dialogue Designer icon in the start menu.
When the Dialogue Designer is started, a blank dialogue is opened.

To open an existing dialogue, go to the File menu and choose Open (CTRL-O). A window is
opened where you can select a folder on your hard disk or network where a dialogue is stored.
Select the dialogue and click the Open button. The application now opens the dialogue file.

To save a dialogue file, go to the File menu and choose Save (CTRL-S). If you want to save the
dialogue file under another name, go to the File menu and choose Save as. To print a dialogue, go
to the File menu and choose Print.

A better way to see how the dialogue will look for the respondent, it to launch the dialogue in your
browser. To do this, go the File menu and choose Preview.

When the dialogue has interactive elements, you can simulate the interactivity in the MDD. To do
this, go to the File menu and choose Interactive Preview. The application launches the interactive
dialogue in a window. By making choices and clicking the next button you can see the interactivity
with the respondent. To see different interactive paths and patterns, you can start the dialogue
from the start by clicking the button Refresh Dialogue at the top of the window.
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3.2 Dialogue properties

A question file consists of two parts: the dialogue properties and a question list. The dialogue
properties hold information in addition to the actual questions. Here you can enter a name for the
dialogue file, see who created the questionnaire and in which language it is written. This
information is necessary to store and catalogue dialogue files and to present them to respondents.
When designing a dialogue file you can switch between the dialogue properties and the question
list by using the tab bar, directly beneath the menu bar.

When you create a new dialogue file or open an existing one, the dialogue properties window is
opened. In this window you can create or edit the appropriate information. The six dialogue
properties are listed below:

Name: The title of the dialogue.

Author: The name of the person who created the dialogue file.

Description: A description of what the dialogue file is. 

Preface: This text is shown to the respondent just before the question list is presented. Here you
can say what the dialogue is about and what you will do with the information.

Epilogue: This text is shown to the respondent after he has filled out the dialogue. An excellent
opportunity to thank a respondent for his or her participation.

Encoding: You can choose UTF-8 or ISO-8859-1 as the encoding for the dialogue. If the language
of the dialogue is an European language (for example English or German), the ISO-8859-1
encoding is apropriate. If you want to use characters that are not present in this encoding (such as
Greek or Asian characters) then choose the UTF-8 encoding. All possible characters are usable if
you choose the UTF-8 encoding.

The Metatude Dialogue Server must be installed with support for Unicode if you wish to use the
UTF-8 encoding. You will not be able to use an UTF-8 encoded dialogue when this support is not
present. In this case, please select ISO-8859-1 as the encoding for the dialogue.

Version: This states the version of the Metatude Dialogue Designer. The dialogues will have this
version number as a property in order to avoid conflicts between different versions of Metatude
software components. You cannot adjust this value.
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Figure 1: An example of dialogue properties.

Font formatting
You can select parts of the text you entered in the Preface and Epilogue fields and format these
fonts bold, italic or underlined using the buttons on the top right hand corner. You can also apply
font formatting on selected text by using the shortcuts CTRL-B, CTRL-I and CTRL-U for resp. bold,
italic and underlined formatting. These font formatting features can also be used througout the
questionairre.
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3.3 Custom Attributes

When a directory server is created in the Metatude Project Manager, custom attributes can be
assigned to each field of the directory server. These custom attributes can be used in dialogues.
The functionality is similar to the custom attributes in invitation and reminder e-mails.

Custom attributes can be inserted in each part of the dialogue. For example, a custom attribute
can be placed in the preface, the question text, the answer text or the epilogue. These tags are
replaced with the particular value in the database for the respondent. If the respondent comes from
a database where this custom attribute has not been defined, this value is left blank. You can insert
custom attributes by entering the name of the attribute between brackets. The custom attribute
tags will appear in blue on your screen.

For example, if a custom attribute called 'Function' is defined, then you can include the value of this
attribute in a dialogue by placing the text <FUNCTION> in the appropriate place. This tag will be
replaced by the value that is in the database for each respondent. You can ask such questions as
'Do you enjoy working as a <FUNCTION>?'. If the database contains the value 'Web Designer' for
a particular respondent, then the question that will be asked is: 'Do you enjoy working as a Web
Designer?'.

Figure 2: Custom attribute in a dialogue
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4 Question list

4.1 Question list

The question list is the area where you can add, edit and delete questions. When you have opened
a dialogue file you can go the question list by clicking on the tab question list.

You can change the sequence of questions by dragging them with the mouse. You can drag a
question by clicking on the gray vertical line in front of the question.

You can open and close a question. When a question is opened, you can see the question text, the
question type, the answers and the question properties. When a question is closed you can only
see the question text and the question type.

To open and close a question click on the triangle4in front of the question text. The triangle is
pointed to the right when a folder is closed and pointed downwards when it is opened. When no
answers are defined, a question cannot be opened. If this is the case, the triangle in front of the
question text is colored in a light shade of gray.

You can open and close a question via the menu bar (Dialogue – Expand/collapse question) or
with your keyboard (CTRL-E). You can expand and collapse all questions at once via the menu bar
or with your keyboard (CTRL- R for expand all and CTRL-T for collapse all).
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4.2 Adding questions and answers

The question list window has an extra bar ('button bar') to add and delete questions and to add
answers. These functions can also be accessed in the menu bar via the item dialogue.

Creating a new question
You can make a new question by clicking on the New question button in the button bar. After this,
proceed as follows:

· enter the question text;

· select the question type and press the 'Enter' key on your keyboard;

· enter the possible answers;

· edit the question properties.

You can switch between these functions using the mouse or by using the TAB-key on your
keyboard.

Figure 3: Question list.

Page break
A page break can be inserted after any question. The questions up to the page break are
presented to a respondent. When the respondent clicks on the next button in a dialogue, the next
set of questions is presented.

Enter the question text
Obviously, each question has a question text. This is the actual question you ask to the
respondent. The question text starts right next to the question number. The first item that is
selected when adding a new question is the question text.

Select the question type
The Metatude Dialogue Designer allows you to create eight different types of questions. It is also
possible to enter an introduction where you can provide additional information that doesn't require
a response. You can select the question type on the right side of the application using the drop
down menu.

Note: Each question type has its own interface. In the next chapter we will show you the different
question types, how to set the right properties and how to enter possible answers.
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Enter the possible answers
Below the question text there is space to enter possible answers. If there are no answers entered
yet, then this space is not visible. Just press 'Enter' after you enter the question text or the question
type. The application will automatically create space for any possible answers.

You can change the sequence of answers by dragging individual answers with the mouse. You can
drag an answer by clicking on the circle or square positioned in front of the answer. You can even
drag answers to another question. To copy an answer, drag the question while holding the CTRL-
button down.

Edit the question properties
Many of the question types also have question options that can be set. These properties determine
the form of the question or make it possible to create a special answer category. The question
properties differ for the different question types. For each question, you can choose the Must
answer option. If this option is selected, then a respondent must answer this question before the
dialogue is submitted, or the next set of questions is presented. The next chapter will explain the
question properties associated with each question.
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5 Question types

5.1 Open questions

An open question is a question to which the respondent can give an 'open answer'. This means
that he is not limited by predefined answer categories. A good example of this question is if you
ask for somebody's name.

When you create an open question in the Metatude Dialogue Designer, the respondent can enter
his answer with his keyboard in a text field. When you choose 'open question' from the drop down
menu and press Enter, a textbox appears. You can enter text in the textbox. This text can provide
an additional direction for the respondent, for instance: 'please enter your name here'. Be sparse
with these directions, the respondent will generally know that the textboxes are meant for entering
his or her answer.

You can set two properties for the open question. First of all you can set the length of the textbox.
This length refers to the width of the textbox. Some questions require less space.

Figure 4: Example of an open question.
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5.2 Comment questions

A comment question (like the open question) is a question where the respondent is not bound by
answer categories to give his answer. The only difference is that the respondent has more space
to define his answer than with the open question. You choose this question type when you expect
an elaborate answer. As with the open question, you can enter a text in the textbox that can
provide an additional direction for the respondent.

You can set two properties for the comment question. Both properties define the space that is
presented to the respondent to enter his question. The first property defines the width (in
characters) of the textbox, the second one the height (in lines). When creating a comment
question, these values are, by default, set to 50 (width) and 3 (height).

Figure 5: Example of comment question.
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5.3 Multiple choice questions

A multiple choice question is a question where the respondent can choose one answer from a list
with predefined answers. A good example of a multiple choice question is to ask in which
department people work, since people generally work only in one department.

After you have entered your question text and selected the option 'multiple choice', you can enter
your predefined answers in the area below the question text. You can insert multiple answers by
clicking the New answer button in the button bar or by clicking the Enter key after you entered a
predefined answer. After this a new answer is inserted automatically. To delete an answer, go to
the Dialogue menu and choose Delete answer. An alternative is to delete the question text and to
click on the backspace button while the cursor is in the empty answer space.

The answers to the question can be displayed in multiple columns. Select the number of columns
by choosing a value for Display in columns.

When you create a multiple choice question, you can use the question properties to add two
special types of answer categories. You can add the answer category Not applicable by checking
the checkbox in the dialogue properties. When respondents mark this answer, a special value is
stored in the results that distinguishes it from normal answer values. The application creates an
answer category with the text 'not applicable'. You can select and change this default text (to
another language for example).

Another special answer category is Other. When you use this category, an answer is inserted
where the respondent can answer the question in a textbox. The respondent can use this when the
predefined answer categories don't fit his or her answer. You can add the answer category 'other'
by checking the checkbox in the dialogue properties. You can select and change the default text.

Figure 6: Example of a multiple choice question.
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5.4 Multiple response questions

A multiple response question is a question where the respondent can choose zero, one or more
answers from a list with predefined answers. Creating a multiple response question is very similar
to a multiple choice question. In the dialogue properties you can choose to insert the two special
answer categories: Not applicable and Other. An additional possibility is to set a limit for the
maximum numbers of answers given. In most cases it is best to leave this value blank (default
value). The answers to the question can be displayed in multiple columns. Select the number of
columns by choosing a value for Display in columns.

Figure 7: Example of a multiple response question.
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5.5 Matrix questions

A matrix question can be seen as a combination of two or more questions. Instead of the same
question for a specific situation, you can ask the question for multiple situations. For instance: if
you defined a list of aspects that people could value in their job and want to know how the
respondent values these aspects as well as how he thinks his co-workers or management value
these aspects. You can ask the respondent the same list three times with three, multiple response
questions. With a matrix question you can combine these three questions into one, with the answer
categories as rows, and the situations as columns.

When you select the Matrix question type, you start with one row and one column. You can add
rows and columns by clicking the Enter key after you have entered a row text or a column text.

To delete an answer, go to the Dialogue menu and choose Delete answer. An alternative is to
delete the question text and to press the Backspace key while the cursor is in the empty answer
space.

Figure 8: Example of a matrix question.
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5.6 Scale questions

A scale question is used when a situation is not black or white. With a scale question the
respondent can indicate to which extent or degree he or she agrees, or values something. Scale
questions are usually used to measure an opinion.

There are many types of scale questions. If you are creating scale questions for the first time this
may seem complicated. Fortunately, you can see how the choices you make are shown to the
respondent. Basically, when you design a scale question you must make four choices:
1. the number of scales;
2. the values of all the scales or only the outer limits of the scales;
3. whether or not you want to use row labels;
4. whether or not you want to use 'Not applicable'.

Figure 9: Example of a 5 scale question.

A few examples will make this clear:

Figure 10: The same scale question, with values for each scale.
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Figure 11: A 6 scale question with 'limits for each row' and an extra scale 'not applicable'.
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5.7 Multiple steps

A multiple steps question can be used when there are a lot of predefined answers and these
answers can be organized in categories. An example is when you ask someone which car he or
she drives. Instead of listing all types of all brands, you can first ask the brand name and then
present a list with specific types for this brand. With a multiple steps question you can help a
respondent to find his way within a large number of predefined answers by organizing the answers
in a logical way.

Figure 12: A multiple steps question.

When you select the 'multiple steps' question type and press the Enter key, three lists are
presented to you in which you can organize your predefined answers. You can choose between
two or three steps (lists) on the right of your screen. First you define the questions for each step.
This can be done just above the lists.

You can enter an answer by clicking with the mouse on the list and entering text. After each
answer, just press the Enter key and you can enter a new answer. To enter questions in the
second or third step, first select the right answer in the previous step. You can see the previous
steps that are selected by their light color. Behind the answer in the first step you can see the total
amount of answers for that answer in the next steps.

You can change the sequence of answers by dragging them with the mouse. To remove an
answer, first select it and then click on the Backspace key while holding the Shift key.
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5.8 Priority questions

You can use a priority question when you want a respondent to indicate a priority among a set of
predefined answers. When you use a priority question, you need to enter the predefined answers
and select how many priorities you want the respondent to indicate. For instance, if you ask for a
top 3 priority, the respondent can choose which predefined answer is priority number 1, priority
number 2 and priority number 3. You can do this by setting the value top in the question properties.

Figure 13: A priority question.
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5.9 Introduction

An introduction is not a question. It doesn't require a respondent to give an answer. An introduction
is meant to provide some additional information at some point in the dialogue. You can use this to
explain why you are asking some questions or to divide the dialogue into sections.

Figure 14: An introduction.
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6 Interactivity

6.1 Types of interactivity

With the Metatude software you can build interactivity into dialogues. Interactivity means that you
can adapt questions and categories based on response given by the respondent. One common
type of interactivity is routing. With routing, you can define the question path based on answers that
are given by the respondent. You can ask different sets of questions for different situations. An
interactive dialogue is served to a respondent in small parts. Each time a decision has been made
that is based on the input of the respondent, a new part of the dialogue is shown.

You can conveniently define interactivity with the Metatude Dialogue Designer. There are three
different types of interactivity possible within the Metatude software.

Piping: transferring a value from a question to another question.
Exampe: If you ask the respondent for the name of his of her car brand, you can ask questions
later that use the name of the brand that the respondent filled out.

Routing: defining a path through the questionnaire based on respondent input
Example: You can ask if someone is satisfied with the service of your company. Based on the
response you ask a different set of questions.

Inheritance: repeating only checked or only unchecked answer categories in subsequent
questions.
Example: You can ask which benefits an employee receives. After this you can ask how satisfied
this person is for every one of the benefits he or she receives.

In the paragraphs to follow, we will explain each of the interactivity types in detail and show how to
define interactivity in the Metatude Dialogue Designer.
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6.2 Originating and receiving questions

Before we explain the different types of interactivity in greater detail we'd like to point out that each
time you define an interactive element in the questionnaire there are two or more questions
involved. One question influences the interactivity, and other questions are influenced by the
defined interactivity.

The influencing question we call an originating interactive question, since the interactivity finds its
origin in this question.

The influenced questions we call receiving interactive questions, since these questions are on the
receiving end of the interactive construction. The questions 'receive' information from the
originating question to which they need to adapt themselves.

A question that receives information from an originating question can never be placed before that
originating question. Note that a question can be both an originating and receiving question at the
same time.

The MDD shows if a question is an interactive origination or receiving (or both) question by
showing an icon containing the letter 'O' for 'originating' or letter 'R' for 'receiving' on the question
text line just to the left of the question properties. It is important that you grasp this concept, since it
will help you understand how to define interactive surveys in the Metatude Dialogue Designer.

Figure 15: Icons just left of the question properties show if a question is an interactive originating or
receiving question.
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6.3 Interactive question: Piping

Piping is transferring an answer to a question, given by a respondent, to another question. You can
literally repeat an answer in the question text of the question that receives the answer. If the
origination question was 'which car brand do you own?' and the respondent gave the answer 'Ford',
you can use this value in the question text of subsequent questions, for instance by asking: 'Are
you satisfied with your Ford?'.

Only questions where a respondent can define just one singe answer are suitable to act as the
origin of a piping question. Hence, only the open question and the multiple choice question can be
used as an origin for piping. In the following table you can see which question types can serve as
an originating question for a piping question and which types can serve as a receiving question.

Question

Originating Receiving

Open question X X

Comment question X

Multiple choice question X X

Multiple response question X

Matrix question X

Scale question X

Multiple steps question X

Priority question X

Figure 16: supported questions for piping.

You can define the receiving piping question, by clicking on the checkbox Pipe from in the
properties menu of that question. A drop down box will appear where you can select the question
number of the question that should be the originating piping question. Only the open questions and
multiple choice questions will be shown in the drop down list, since these are the only supported
originating questions for piping.

In the receving question you can place four dots (....) in the place where you would like the
originating value to be inserted in the question text. In the survey process, the software will replace
the four dots with the value the respondent gave in the originating question. An example of an
interactive piping construction is shown in the figure below.
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Figure 17: An interactive piping construction

Please note in this example that if a user answers that the first question is 'not applicable', the
receiving question will be automatically be skipped in the survey process.
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6.4 Interactive question: Routing

Routing is defining a path through the questionnaire based on input given by the respondent. A
'path' can only originate at a multiple choice question. Every question can be a receiving question.
Underneath the table of supported questions for routing is shown.

Question

Originating Receiving

Open question X

Comment question X

Multiple choice question X X

Multiple response question X

Matrix question X

Scale question X

Multiple steps question X

Priority question X

Figure 18: supported questions for routing.

In order to define a path, you check the checkbox Routing in the question properties of the
multiple choice question that has to become the origin of the routing. The MDD will show a drop
down menu for all the answers that you have defined for the multiple choice question. The
dropdown boxes contain all the question numbers in the dialogue that follow the current question.
You can not route to an earlier question. For each answer you can now specify which question
should be the next question, if the respondent chooses this answer. Figure 19 shows an example
of an interactive routing construction.

Figure 19: An interactive routing construction.
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A special case of routing is the Jump to possibility. With this feature you can define that a
respondent should jump to a specific question regardless of which answer the respondent has
given. The jump to can be specified for every question type, not just a multiple choice question.
You specify a jump at the originating question. In the question properties there is a Jump to value
with a drop down box. This has the default value Next (since normally a user should continue with
the next question in the dialogue). Here you can set a specific question number or the value End
(in case you want the respondent to jump to the end of the survey.

Using this feature might not look very logical at first sight, for it seems that each respondent skips
the same set of questions when the jump to feature is used. You could reason that leaving these
skipped questions out of the survey might have the same result. It is only in combination with the
routing functionality that the jump to feature is usefull. To explain this, an example follows

Suppose that you want to aks respondents if they have a car. If they do, you want to ask them
which brand of car they have. If they don't have a car, you want to ask them why. This example is
shown in figure 20.

Figure 20: A combination of routing and 'jump to' creates different legs is a survey.

With the routing functionality you can route respondents who have a car to question 2 and
respondents that don't have a car to question 3. Without jumping, respondents that have a car will
continue with question 3 after having answered question 2. Question 3 is the wrong question for
those respondents. You can solve this by defining that regardless of what people answer in
question 2, they should jump to question 4. With the 'jump to' functionality you can create different
legs in a survey.
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6.5 Interactive question: Inheritance

When you use inheritance, answers from a previous question are transferred to following
questions. Which answers are inherited depends on what the respondent has filled out at the
originating question. Inheritance is a very powerfull interactive feature that allows you to 'zoom in'
on specific issues, without asking questions that don't make sense to the respondent. The
originating question for inheritance can only be of the multiple response type. You can find the
supported receiving question types in the table below.

Question

Originating Receiving

Open question

Comment question

Multiple choice question X

Multiple response question X X

Matrix question X

Scale question X

Multiple steps question

Priority question X

Figure 21: supported questions for inheritance.

A good example of a situation where you can use inheritance is when you want to ask a
respondent which websites he or she knows and subsequently you want to ask the respondent his
or her opinion on those websites. It wouldn't make sense to ask respondents their opinion on
specific websites if they have never visited those sites. You can solve this by using inheritance.

In this specific case you would first define a multiple response question that asks respondents
which sites they have visited. After this question, you can define a scale question where the
respondents can give their opinion on the sites that they have visited. Next, you can define that the
scale question positively inherits the answers the respondents checked in the previous multiple
response question. The respondents now only have to rate the sites they know about.

A question can positively or negatively inherit answers from a multiple response question. When
the inheritance is positive, only the categories that the respondent checked will be shown in the
receiving inheritance quesion. When inheritance is negative, only the categories that the
respondent did not check will be shown in the receiving inheritance question. In the above
example, if you use negative inheritance, you could ask why respondents didn't visit the other sites.

In order to define an inheritance question, you check the check box Inherit from in the question
properties of the receiving question. A drop down menu will appear on the right side of the 'Inherit
from' check box. This drop down menu contains the question numbers of all the preceeding
multiple response questions. You can select the originating question you want the receiving
question to inherit from.

After you select the question number to inherit from you see all the answers of the originating
question appear as answer categories of the receiving question. These categories are shown in a
light grey color to indicate that they are not editable. If you want to edit the categories, you should
do this in the originating question. Changes made there are also directly reflected in the receiving
questions.

Just to the right of the drop down box there is an icon that shows if the inheritance is positive or
negative. This is shown by a + (positive) or a - (negative) symbol. The default value is positive. To
change the value just click on the symbol.
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Besides inheriting categories directly from an originating question, it is also possible to add new
categories to these inherited categories. The new categories will always be shown to the
respondent.

Figure 22: An interactive inheritance construction.

The inheritance feature is implemented with built in intelligence that makes the software flexible to
use and avoids situations that are not logical to the respondent:
- You can use the category 'other' in the originating question. Whatever the respondent fills out in
this field is repeated in associated positive inheritance questions.
- If a respondent checks no category at all in the originating question, the associated positive
inheritance questions are skipped automatically.
- You can define 'multiple inheritance' dialogues. This means that a receiving inheritance question
(only of the multiple response type) can act as an originating inheritance question
- You can use the same multiple response question several times for different receiving inheritance
questions.
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7 Preferences

7.1 Selecting stylesheets

Stylesheets are used to format the question lists in webbrowsers. To preview a dialogue, a
stylesheet is needed. The Metatude Dialogue Designer (MDD) comes with a default stylesheet.
You can also use your own stylesheets. The procedure is described below:

First, choose Edit > Preferences from the menu bar. The preferences window for the MDD is
shown.

Figure 23: MDD preferences, selecting stylesheets.

Click on the Change ... button to select your own stylesheet. The stylesheet that you have selected
will be used to preview your dialogues. The same stylesheet is used for the interactive and normal
previews.

Click on the Restore Default button to restore the original stylesheet.
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7.2 Selecting a font

In the Font tab of the preferences window, you can select which font is used in the Dialogue
Designer application. The font you select here will not be used in the browser of the respondent, it
is only used in the screens of the Dialogue Designer. You can select any font that is installed on
your system.

To select a font, choose Edit > Preferences from the menu bar. The preferences window for the
MDD is shown. Click on the Font tab.

Figure 24: Selecting a font

After selecting the desired font, pres OK. The font will be used in the layout of the questions list.
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